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Appendix C: Simulink
Tutorial

C.1 Introduction
Readers who are studying MATLAB may want to explore the functionality and convenience
of Simulink. Before proceeding, the reader should have studied Appendix B, the MATLAB
Tutorial, including Section B.1, which is applicable to this appendix.

Simulink Version 8.3 and MATLAB Version 8.3(R2014a) are required in order to use
Simulink. In addition, if you wish to pursue the design of PID controllers discussed in
Section C.4, you will need the Simulink Control Design Version 4(R2014a) add-on.

The models described in this appendix are available at www.wiley.com/college/nise.
The code will also run on workstations that support MATLAB. Consult the MATLAB
Installation Guide for your platform for minimum system hardware requirements.

Simulink is used to simulate systems. It uses a graphical user interface (GUI) for you
to interact with blocks that represent subsystems. You can position the blocks, resize the
blocks, label the blocks, specify block parameters, and interconnect blocks to form complete
systems from which simulations can be run.

Simulink has block libraries from which subsystems, sources (that is, function
generators), and sinks (that is, scopes) can be copied. Subsystem blocks are available
for representing linear, nonlinear, and discrete systems. LTI objects can be generated if the
Control System Toolbox is installed.

Help is available on the Quick Access Toolbar at the top of the MATLAB R2014a
window. Click the circled question mark and select Simulink. Help is also available for each
block in the block library and is accessed either by right-clicking a block’s icon in the
Simulink Library Browser and selecting Help for or by double-clicking the block’s icon
and then clicking theHelp button. Finally, screen tips are available for some toolbar buttons.
Let your mouse’s pointer rest on the button for a few seconds to see the explanation.

C.2 Using Simulink
The following summarize the steps to take to use Simulink. Section C.3 will present four
examples that demonstrate and clarify these steps.

1. Access Simulink The Simulink Library Browser, from where we begin Simulink, is
accessed by typing simulink in the MATLABCommandWindow or by clicking on the
Simulink Library button on the toolstrip, shown circled in Figure C.1.

In response, MATLAB displays the Simulink Library Browser shown in
Figure C.2(a). We now create an untitled window, Figure C.2(b), by clicking on the
New model button (shown circled in Figure C.2(a)) on the toolbar of the Simulink
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FIGURE C.1 MATLAB Window showing how to access Simulink. The Simulink Library Browser button is shown circled

FIGURE C.2 a. Simulink Library Browser window showing the New model button encircled;
(!gure continues)
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Library Browser. You will build your system in this window. Existing models may be
opened by clicking on the Open model button on the Simulink Library Browser
toolbar. This button is immediately to the right of the New model button. Existing
models may also be opened from the File section of the Home tab on the Toolstrip or
from the Searchbar below the Toolstrip on the MATLAB window.

2. Select blocks Figure C.2(a) shows the Simulink Library Browser from which all
blocks can be accessed. The left-hand side of the browser shows major libraries, such as
Simulink, as well as underlying block libraries, such as Continuous. The right-hand side
of Figure C.2(a) also shows the underlying block libraries. To reveal a block library’s
underlying blocks, select the block library on the left-hand side or double-click the block
library on the right-hand side. As an example, the Continuous library blocks under the
Simulink major library are shown exposed in Figure C.3(a). Figures C.3(b) and C.3(c)
show some of the Sources and Sinks library blocks, respectively.

Another approach to revealing the Simulink block library is to type open_system
(‘simulink’) in the MATLAB CommandWindow. The window shown in Figure C.4 is
the result. Double-clicking any of the libraries in Figure C.4 reveals an individual
window containing that library’s blocks, equivalent to the right-hand side of the
Simulink Library Browser as shown in the examples of Figure C.3.

3. Assemble and label subsystems Drag required subsystems (blocks) to your model
window from the browser, such as those shown in Figure C.3. Also, you may access the
blocks by double-clicking the libraries shown in Figure C.4. You can position, resize, and
rename the blocks. To position, drag with the mouse; to resize, click on the subsystem and
drag the handles; to rename, click on the existing name, select the existing text, and type the
new name.

4. Interconnect subsystems and label signals Position the pointer on the small arrow on
the side of a subsystem, press the mouse button, and drag the resulting cross-hair pointer
to the small arrow of the next subsystem. A line will be drawn between the two
subsystems. Blocks may also be interconnected by single-clicking the !rst block
followed by single-clicking the second block while holding down the control key.
You can move line segments by positioning the pointer on the line, pressing the mouse
button, and dragging. Branches to line segments can be drawn by positioning the pointer
where you want to create a line segment, holding down the mouse’s right button, and

FIGURE C.2 (Continued ) b. resulting untitled model window
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FIGURE C.3 Simulink block libraries: a. Continuous systems; b. Sources (!gure continues)

822 Appendix C: Simulink Tutorial



WEBBAPPC 10/28/2014 21:33:38 Page 823

dragging the resulting cross hairs. A new line segment will form. Signals can be labeled
by double-clicking the line and typing. Finally, labels can be placed anywhere by double-
clicking and typing into the resulting box.

5. Choose parameters for the subsystems Double-click a subsystem in your model
window and type in the desired parameters. Some explanations are provided in the Block

FIGURE C.3 (Continued ) c. Sinks

FIGURE C.4 Simulink Block Library window
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Parameters window. Press the Help button in the Block Parameters window for more
details. Explore other options by right-clicking on a block.

6. Choose parameters for the simulation Select Model Con!guration Parameters
under the Simulationmenu in your model window to set additional parameters, such as
simulation time. Press the Help button in the Con!guration Parameters window for
more details.

7. Start the simulation Make your model window the active window. Double-click the
Scope block (typically, the scope is used to view the simulation results) to display the
Scope window. Select Run under the Simulation menu in your model window or click
on the Run icon on the toolbar of your model window as shown in Figure C.2(b).
Clicking the Stop icon will stop the simulation before completion.

8. Interact with the plot In the Scope window, using the toolbar buttons, you can zoom in
and out, change axes ranges, save axis settings, and print the plot. Right-clicking on the
Scope window brings up other choices.

9. Save your model Saving your model, by choosing Save under the File menu, creates a
!le with an .mdl extension, which is required.

C.3 Examples
This section will present four examples of the use of Simulink to simulate linear, nonlinear,
and digital systems. Examples will show the Simulink block diagrams as well as explain the
settings of parameters for the blocks. Finally, the results of the simulations will be shown.

Example C.1

Simulation of Linear SystemsSimulation of Linear Systems
Our !rst example develops a simulation of three linear systems to compare their step
responses. In particular, we solve Example 4.8 and reproduce the responses shown in
Figure 4.24. Figure C.5 shows a Simulink block diagram formed by following Steps 1
through 5 in Section C.2 as follows:

Access Simulink; select, assemble, and label subsystems The source is a 1-volt step
input, obtained by dragging the Step block from the Simulink Library Browser under
Sources to your model window.

The !rst system, T1, consists of two blocks, Gain and Transfer Fcn. Gain is
obtained by dragging the Gain block from the Simulink Library Browser under Math
Operations to your model window. Transfer function, T1, is obtained by dragging the
Transfer Fcn block from the Simulink Library Browser under Continuous to your
model window. Systems T2 and T3 are created similarly.

The three output signals, C1, C2, and C3, are multiplexed for display into the single
input of a scope. The Mux (multiplexer) is obtained by dragging the Mux block from the
Simulink Library Browser under Signal Routing to your model window.

The sink is a scope, obtained by dragging the Scope block from the Simulink
Library Browser under Sinks to your model window.

Alternatively, all blocks can be dragged from the Library: simulink window shown in
Figure C.4. TheMux can be found under SignalRouting in theLibrary: simulinkwindow.

The labels for the blocks can be changed to those shown in Figure C.5 by following
Step 3 in Section C.2.
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Interconnect subsystems and label signals Follow Step 4 to interconnect the
subsystems and label the signals. You must set the mux’s parameters before the wiring
can be completed. See the next paragraph.

Choose parameters for the subsystems Let us now set the parameters of each block
using Step 5. The Block Parameters window for each block is accessed by double-
clicking the block on your model window. Figure C.6 shows the Block Parameters
windows for the 1-Volt step input, gain, transfer function 1, and mux. Set the parameters
to the required values as shown.

FIGURE C.5 Simulink block
diagram for Example C.1

FIGURE C.6 Block parameters windows for a. 1-Volt step source; (!gure continues)
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FIGURE C.6 (Continued ) b. gain; c. transfer function 1; d. mux
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The scope requires further explanation. Double-clicking the Scope block in your model
window accesses the scope’s display, Figure C.7(a).

FIGURE C.7 Windows for the scope: a. Scope; b. ‘Scope’ parameters, General tab; c. ‘Scope’ parameters, History tab;
d. ‘Scope’ parameters, Style tab; (!gure continues)
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Clicking the Parameters icon on the Scope window toolbar, shown in Figure C.7(a),
accesses the ‘Scope’ parameters window as shown in Figure C.7(b). The ‘Scope’
parameters window contains three tabs, General, History, and Style, as shown in
Figure C.7(b), (c), and (d), respectively.

Finally, right-clicking in the plotting area in the Scope window and selecting Axis
properties . . . reveals the ‘Scope’ properties: axis 1 window, Figure C.7(e). We now
can set the display parameters, such as amplitude range.

Choose parameters for the simulation Follow Step 6 to set simulation parameters.
Figure C.8 shows the resulting Con!guration Parameters window. Among other
parameters, the simulation start and stop times can be set.

Start the simulation Now run the simulation by following Step 7. Figure C.9 shows
the result in the Scope window. Plots are color coded in the order in which they appear at
the mux input as follows: yellow, magenta, cyan, red, green, and dark blue. If the mux
has more inputs, the colors recycle. Colors can be changed in the Style tab of the ‘Scope’
parameters window.

FIGURE C.7 (Continued ) e. ‘Scope’ properties axis 1

FIGURE C.8 Con!guration
Parameters window for Solver
tab
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Interact with the plot The toolbar of the Scope window shown in Figure C.9 has
several buttons that can be used to interact with the plot. Let us summarize the function
and operation of each, starting with the left-most button:

Button 1 executes a plot print.
Button 2 has already been explained and is used to set scope parameters.
Button 3 permits zooming into the plot in both the x and y directions. Press the button and drag a rectangle over the

portion of the curve you want to expand.
Button 4 allows zooming in the x direction only. Drag a horizontal line over the plot covering the extent of x you want

to expand.
Button 5 allows zooming in the y direction only. Drag a vertical line over the plot covering the range of y you want to

expand.
Button 6 autoscales axis for use after zooming.
Button 7 saves current axis settings.
Button 8 restores saved axis settings.
Button 9 toggles "oating scope. It must be turned off to use zooming. See documentation

for use of "oating scopes.
Button 10 toggles lock for current axis selection.
Button 11 allows selection of signals to view when using "oating scope.

FIGURE C.9 Scope window
after Example C.1 simulation
stops
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Example C.2

Effect of Ampli!er Saturation on Motor's Load Angular
Velocity
Effect of Ampli!er Saturation on Motor's Load Angular
Velocity
This example, which generated Figure 4.29 in the text, shows the use of Simulink to
simulate the effect of saturation nonlinearity on an open-loop system. Figure C.10 shows
a Simulink block diagram formed by following Steps 1 through 5 in Section C.2 above.

Saturation nonlinearity is an additional block that we have not used before.
Saturation is obtained by dragging to your model window the Saturation block in the
Simulink Library Browser window under Discontinuities as shown in Figure C.11(a)
and setting its parameters to those shown in Figure C.11(b).

FIGURE C.10 Simulink
block diagram for Example C.2

FIGURE C.11 a. Simulink
library for nonlinearities;
(!gure continues)
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Now run the simulation by making your model window active and selecting
Run under the Simulation menu of your model window or clicking on the Run
button on your model window toolbar. Figure C.12 shows the result in the Scope
window.

FIGURE C.11 (Continued )
b. parameter settings for
saturation

FIGURE C.12 Scope window after simulation of Example C.2 stops. The lower curve is the
output with saturation
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Example C.3

Simulating Feedback SystemsSimulating Feedback Systems
Simulink can be used for the simulation of feedback systems. Figure C.13(a) is an
example of a feedback system with saturation.

In this example, we have added a feedback path (see Step 4 in Section C.2) and a
summing junction, which is obtained by dragging the Sum block from the Simulink
Library Browser, contained in the Math Operations library, to your model window.
The Function Block Parameters: Sum window, Figure C.13(b), shows the parameter
settings for the summer. You can set the shape as well as set the plus and minus inputs. In

FIGURE C.13 a. Simulation block diagram for a feedback system with saturation; b. block
parameter window for the summer
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the list of signs, the “|”symbol signi!es a space. We place it at the beginning to start the
signs at “nine o'clock,” conforming to our standard symbol, rather than at “12 o’clock.”
The result of the simulation is shown in Figure C.14.

Example C.4

Simulating Digital SystemsSimulating Digital Systems
This example demonstrates two methods of generating digital systems via Simulink for
the purpose of simulation, as shown in Figure C.15.

FIGURE C.15 Simulink
block diagram for simulating
digital systems two ways

FIGURE C.14 Simulation
output for Example C.3
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The !rst approach uses a linear transfer function cascaded with a Zero-Order Hold
block obtained from the Simulink Library Browser under the Discrete block library,
shown on the right-hand side of Figure C.16. The second method uses a discrete transfer
function also obtained from the Simulink Library Browser under the Discrete block
library. The remainder of the block diagram was obtained by methods previously
described.

The block parameters for the Zero-Order Hold and Discrete Transfer Fcn blocks
are set as shown in Figures C.17(a) and (b), respectively.

Select Model Con!guration Parameters under the Simulation menu in your
model window and set the simulation stop time to 4 seconds, the type to !xed-step,
and the solver to ode4 (Runge-Kutta). The result of the simulation is shown in
Figure C.18.

FIGURE C.16 Simulink library of discrete blocks

FIGURE C.17 Function Block parameter windows for: a. Zero-Order Hold block;
(!gure continues)
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FIGURE C.18 Outputs of the digital systems

FIGURE C.17 (Continued ) b. Discrete Transfer Fcn block
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C.4 Using Simulink for Control System Design
In this section we show how to use Simulink to design control systems to meet speci!cations
previously discussed in this book. We can make gain adjustments and design compensators
using our Simulink system along with other windows that give us instant veri!cation of our
design. Speci!cally, we will concentrate on the design of PID compensators. We will show that
PID compensators can be designed automatically or by adjusting design tools, such as response
time and transient behavior. As we make adjustments, we see the immediate result of our design
in lists of speci!cations or time responses along with the automatic calculation of the PID gains.

In order to perform control system design, you will need to add the Simulink! Control
DesignTM module Version 4.0 (R2014a), which contains all the necessary tools. Simulink
designs PID controllers using derivative control with a low-pass !lter to reduce noise. The
design requires negative values of derivative gain, which you will notice in the design
examples. We !rst cover the automated design of PID controllers. Next, we cover PID design
using graphical methods.

Automated Design of PID Controllers
The automated design of PID gains generates reasonable robustness and response time. After
the initial design, further adjustments are available, including response time, bandwidth, and
phase margin. Let us !rst enumerate the steps involved, followed by an example.

1. Create a Simulink diagram Begin with a linear or nonlinear feedback control system
containing a PID controller.

2. Set initial values for the PID controller Double-click the PID controller and launch
the Function Block Parameters: PID Controller window. On the MAIN tab, input
nominal values for the Controller parameters. Click Apply.

3. Tune the PID controller Click Tune . . . in the Function Block Parameters: PID
Controller window. The system is linearized and the PID Tuner window is launched
showing the nominal values response (Block response) and the designed response
(Tuned response). Click the Show parameters button on the Toolstrip of the PID
Tuner window to expose performance data, including the designed PID gains. If the
response meets requirements, then click the Update Block button on the Toolstrip of the
PID Tuner window to write the PID parameters to the controller.

4. Modify the design via interactive tuning If required, change the performance by
moving the Response Time and Transient Behavior sliders in the middle of the
Toolstrip of the PID Tuner window. Click the Update Block to write the PID
parameters to the controller. If the system is nonlinear, you should run the simulation
to see the effect of the nonlinearity on the designed response.

Example C.5

Automated Design of a PID ControllerAutomated Design of a PID Controller
In this example we follow the previously enumerated steps to automate the design of a
PID controller for the system of Figure C.19. The requirements are (1) less than 1 second
settling time; and (2) less than 5% overshoot.

Create a Simulink diagram We create the Simulink block diagram of Figure C.19
where the PID controller block is found in the Simulink Library Browser as shown in
Figure C.3(a).

Set initial values for the PID controller Double-clicking the PID controller results in
Figure C.20. For initial values we have chosen unity and clicked Apply.
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FIGURE C.19 Simulink block diagram for automated design of a PID controller

FIGURE C.20 Function Block Parameters window for the PID controller
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Tune the PID controller Click Tune . . . in Figure C.20 to launch the PID Tuner
window shown in Figure C.21(a). Click the Show Parameters button, shown encircled,
on the Toolstrip of the PID Tuner window to display parameters and performance.
Modify the design via interactive tuning Following the instructions in Step 4 on
page 836, we continue tuning the controller using the Response Time and Transient
Bahavior sliders. Finally, click the Update Block button to write the PID parameters to
the controller. The !nal design is shown in Figure C.21(b).

FIGURE C.21 PID Tuner window: a. before additional tuning; b. after additional tuning
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Automated Tuning of PID Controllers and Graphical Design
In this subsection, we begin PID design with automated tuning followed by graphical design
of our choice using Bode plots, root locus, etc. Let us !rst enumerate the steps involved
followed by an example.

1. Create a Simulink diagram Begin with a linear or nonlinear feedback control system
containing a PID controller.

2. Begin compensator design From the menu bar of your Simulink block diagram
select Analysis /Control Design/Control System Designer . . . launching the Control
and Estimation Tools Manager window.

3. Select block to tune In the Control and Estimation Tools Manager window, click
Select Blocks. . . . In the resulting Select Blocks to Tune window, choose PID
Controller and click OK.

4. Choose the closed-loop response for which response will be analyzed On the
Simulink block diagram, choose the input and output for the closed-loop. Right-click at
the input and choose Linear Analysis Points/Input Perturbation. Right-click at the
output point and choose Linear Analysis Points/Output Measurement. Small vertical
arrows result at these points to indicate your selection.

5. Tuneblocksand launch theDesignCon!gurationWizard ClickTuneBlocks . . . and
launch the Design Con!guration Wizard. Click Next and select the graphical plots
you want to use for design. ClickNext and choose the Analysis Plots you want to use to
analyze the design. Check the Contents of Plots boxes that correspond to the
Responses you want your Analysis Plots to display. Click Finish and launch the
LTI Viewer for SISO Design Task window that contains the Analysis Plots you
selected. Also launched is the SISO Design for SISO Design Task window that
contains the graphical design plots that you previously selected.

6. Perform automatic tuning of the PID controller In the Control and Estimation
Tools Manager window select the Automated Tuning tab at the top right. Select PID
Tuning in the Design method: drop-down menu. Select Tuning method and Control-
ler Type. Click Update Compensator, which selects compensator gains and updates the
response and graphical design curves. Click Update Simulink Block Parameters.

7. Evaluate performance Right-click the response curve and select Characteristics.
Select each desired choice under Characteristics, adding a plot marker to the curve
at the appropriate measurement point. Click on each marker to read the performance
data.

8. Improve performance by interacting with the graphical design plots Change PID
poles and gains until your response meets the requirements. You may add performance
boundaries by right-clicking the design graphic and selecting Design Requirements/
New. . . . From the pull-down menu select the desired requirements. Upon closing the
window the performance boundary is placed on the graphical design plot.

Example C.6

Automated Tuning of a PID Controller and Graphical DesignAutomated Tuning of a PID Controller and Graphical Design
In this example we follow the previously enumerated steps to automatically design a
PID controller for the system of Figure C.19 and follow with further improvement in
performance using root locus. The requirements are: (1) less than 1 second settling
time; and (2) less than 4% overshoot.
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Create a Simulink diagram We create the Simulink block diagram of Figure C.19
where the PID controller block is found in the Simulink Browser Library as shown in
Figure C.3(a).

Begin Compensator design In Figure C.19, we select Analysis /Control Design/
Compensator Design . . . , launching the Control and Estimation Tools Manager
window shown in Figure C.22(a).

FIGURE C.22 a. Control and Estimation Tools Manager window before selecting block to
tune; b. Select blocks to Tune window; (!gure continues)

840 Appendix C: Simulink Tutorial



WEBBAPPC 10/28/2014 21:33:45 Page 841

Select blocks to tune Click Select Blocks . . . in Figure C.22(a) and launch the
Select Blocks to Tune window shown in Figure C.22(b). Select PID Controller
and click OK. The resulting Control and Estimation Tools Manager is shown in
Figure C.22(c).

Choose the closed-loop response for which response will be analyzed On the Simu-
link block diagram, right-click the output of the step input and select Linear Analysis
Points/Input Perturbation, placing a small down-arrow with a summing junction at
that point, signifying the input of the closed-loop response. Similarly, the closed-loop
output is chosen by right-clicking the output of the plant and selecting Linear Analysis
Points/Output Measurement. A small up-arrow results, signifying the output of the
closed-loop system. The resulting Simulink block diagram is shown in Figure C.23.

Tune blocks and launch the Design Con!guration Wizard Click Tune Blocks . . .
in Figure C.22(c) and launch the Design Con!guration Wizard. Click Next. The
resulting window is shown in Figure C24(a). Select Root Locus in the Plot Type pull-
down menu for Plot 1. Click Next to select the plot to be used for analysis as shown in
Figure C.24(b). For this case we choose Step for Plot 1, Plot Type. Also check the
box for Plot 1 below to indicate the Responses as shown.

FIGURE C.22 (Continued) c. Control and Estimation Tools Manager window after selecting
block to tune

FIGURE C.23 Simulink
block diagram showing
closed-loop input and
output points
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Click Finish and launch the LTI Viewer for SISO Design Task window that contains
the step response you selected for analysis. Also launched is the SISO Design for SISO
Design Task window that contains the root locus plot that you previously selected for
design. Before we discuss these two plots, we !rst perform automatic PID tuning.

Perform automated tuning of the PID controller The Control and Estimation
Tools Manager now looks like that shown in Figure C.25 after selecting the Automated
Tuning tab at the top and making the selections shown in the !gure. Click Update
Compensator and Update Simulink Block Parameters. You should notice a marked
improvement in the step response as shown in Figure C.26.

FIGURE C.24 Design Con!gurationWizard: a. with root locus selected as the design tool;
b. with closed-loop step response selected as analysis tool
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Evaluate performance Right-click on the response curve shown in Figure C.26 and
choose Characteristics. Select Peak Response and Settling Time. Blue dots are
placed on the response curve at the appropriate points. Click on each dot to reveal the
performance. In this case we see that automatic tuning yields 6.77% overshoot and 1.56
settling time. The requirements are not met.

FIGURE C.25 Control and Estimation Tools Manager prepared for automatic
PID tuning

FIGURE C.26 LTI Viewer for SISO Design Task window showing closed-loop
step response after automatic PID tuning
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Improve performance by interacting with the graphical design plots We now
reshape the root locus plot in order to improve performance and meet the require-
ments. On the root locus shown in the SISO Design for SISO Design Task
window, right-click and select Design Requirements/New. . . . In the pull-down
menu select Settling time and type in 1 second. Click OK. Right-click again and
choose Design Requirements/New. . . . In the pull-down menu select Percent
overshoot and type in 4. Click OK. In response, design boundaries are placed on the
root locus. See Figure C.27.

The white space represents responses faster than 1 second settling time and overshoot
less than 4%. Now adjust root locus gain (red squares), PID zero (red zero), and/or PID
pole (red x). These are adjusted by letting your mouse rest on the selected red indicator
until it turns into a hand. Then move the indicator. Shape the root locus until an operating
point falls within the white area. After adjustments, we obtain the root locus shown in
Figure C.28(a) and the time response shown in Figure C.28(b) . We conclude that the
design requirements are met.

FIGURE C.27 Root locus showing design boundaries of 4% overshoot (radial lines) and
1 second settling time (vertical line) with adjustable gain, PID zero, and PID pole
shown in red
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FIGURE C.28 Final design as shown in a. root locus; b. step response
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Summary
This appendix explained Simulink, its advantages, and how to use it. Examples were taken
from Chapters 4, 5, and 13 and demonstrated the use of Simulink for simulating linear,
nonlinear, and digital systems.

In addition, we showed how to use the Simulink Control Design add-on to
automatically tune PID controllers and perform shaping of graphical design tools in order
to meet performance requirements.

The objective of this appendix was to familiarize you with the subject and get you
started using Simulink. There are many blocks, parameters, and preferences that could not
be covered in this short appendix. You are encouraged to explore and expand your use of
Simulink by using the on-screen help that was explained earlier. The references in the
Bibliography of this appendix also provide an opportunity to learn more about Simulink.
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The designed compensator is displayed in the Control and Estimation Tools Man-
ager under the Compensator Editor tab. Be sure to click the Update Simulink Block
Parameters button at the bottom to update your Simulink model. The result is shown in
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FIGURE C.29 PID meeting design requirements
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